
Introducing
Excel

This chapter serves as an introductory overview of Excel.
It is intended primarily for those who have no experience

with this product. But even if you’re already familiar with Excel,
you may find a few new wrinkles here. If you’re moving up from
Excel 2002, you’ll also find a quick summary of the new fea-
tures in Excel 2003.

What Is It Good For?
Excel, as you probably know, is a spreadsheet program and is
part of the Microsoft Office suite. Several other spreadsheet
programs are available, but Excel is by far the most popular.

Much of the appeal of Excel is due to the fact that it’s so ver-
satile. Excel’s forte, of course, is performing numerical calcu-
lations, but Excel is also very useful for non-numerical
applications. Here are just a few of the uses for Excel:

✦ Number crunching: Create budgets, analyze survey
results, and perform just about any type of financial
analysis you can think of.

✦ Creating charts: Create a wide variety of highly cus-
tomizable charts.

✦ Organizing lists: Use the row-and-column layout to store
lists efficiently.

✦ Accessing other data: Import data from a wide variety of
sources.

✦ Creating graphics and diagrams: Use Excel AutoShapes
to create simple (and not-so-simple) diagrams.

✦ Automating complex tasks: Perform a tedious task with
a single mouse click with Excel’s macro capabilities.

11C H A P T E R

✦ ✦ ✦ ✦

In This Chapter

Understanding what
Excel is used for

Using Excel menus,
toolbars, and dialog
boxes

Navigating Excel
worksheets

Introducing Excel
with a quick hands-on
session

✦ ✦ ✦ ✦
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4 Part I ✦ Getting Started with Excel

Understanding Workbooks and Worksheets
The work you do in Excel is performed in a workbook file, which appears in its own
window. You can have as many workbooks open as you need. By default, work-
books use an XLS file extension.

Each workbook is comprised of one or more worksheets, and each worksheet is made
up of individual cells. Each cell contains a value, a formula, or text. Each worksheet
is accessible by clicking the tab at the bottom of the workbook. In addition, work-
books can store chart sheets. A chart sheet displays a single chart and is also acces-
sible by clicking a tab.

Newcomers to Excel are often intimidated by all of the different elements that appear
within Excel’s window. You’ll soon see that the Excel screen really isn’t all that diffi-
cult to understand after you learn what the various pieces do.

Figure 1-1 shows you the more important bits and pieces of Excel. As you look at
the figure, refer to Table 1-1 for a brief explanation of the items shown in the 
figure.

Table 1-1
Parts of the Excel Screen That You Need to Know

Name Description

Active cell indicator This dark outline indicates the currently active cell (one of
the 16,777,216 cells on each worksheet).

Application close button Clicking this button closes Excel.

Window close button Clicking this button closes the active workbook 
window.

Column headings Letters range from A to IV — one for each of the 256
columns in the worksheet. After column Z comes column
AA, which is followed by AB, AC, and so on. After column
AZ comes BA, BB, and so on until you get to the last
column, labeled IV. You can click a column heading to
select an entire column of cells.

Formula bar When you enter information or formulas into Excel, they
appear in this line.

Horizontal scrollbar Enables you to scroll the sheet horizontally.
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5Chapter 1 ✦ Introducing Excel

Name Description

Maximize/Restore button Clicking this button increases the workbook window’s size
to fill Excel’s complete workspace. If the window is already
maximized, clicking this button “unmaximizes” Excel’s
window so that it no longer fills the entire screen.

Menu bar This is Excel’s main menu. Clicking a word on the menu
drops down a list of menu items, which is one way for you
to issue a command to Excel.

Minimize application button Clicking this button minimizes Excel’s window.

Minimize window button Clicking this button minimizes the workbook window.

Name box Displays the active cell address or the name of the selected
cell, range, or object.

Row headings Numbers range from 1 to 65,536 — one for each row in the
worksheet. You can click a row heading to select an entire
row of cells.

Sheet tabs Each of these notebook-like tabs represents a different
sheet in the workbook. A workbook can have any number
of sheets, and each sheet has its name displayed in a sheet
tab. By default, each new workbook that you create
contains three sheets.

Tab scroll buttons These buttons let you scroll the sheet tabs to display tabs
that aren’t visible.

Status bar This bar displays various messages as well as the status of
the Num Lock, Caps Lock, and Scroll Lock keys on your
keyboard.

Task pane This pane displays options that are relevant to the task you
are performing.

Task pane selector Clicking here enables you to select from different task
panes so you can open workbooks, use the Office
Clipboard, or work with XML data.

Title bar All Windows programs have a title bar, which displays the
name of the program and holds some control buttons that
you can use to modify the window.

Toolbars The toolbars hold buttons that you click to issue commands
to Excel. Some of the buttons expand to show additional
buttons or commands.

Vertical scrollbar Lets you scroll the sheet vertically.
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6 Part I ✦ Getting Started with Excel

Figure 1-1: The Excel screen has many useful elements that you will use often.

Moving Around a Worksheet
This section describes various ways to navigate through the cells in a worksheet.
Every worksheet consists of rows (numbered 1 through 65,536) and columns (labeled
A through IV). After column Z comes column AA; after column AZ comes column
BA, and so on. The intersection of a row and a column is a single cell. At any given
time, one cell is the active cell. You can identify the active cell by its darker border,
as shown in Figure 1-2. Its address (its column letter and row number) appears in
the Name box. Depending on the technique that you use to navigate through a
workbook, you may or may not change the active cell when you navigate.

Window close button

Tab scroll buttons

Sheet tab Horizontal scrollbar

Vertical scrollbar

Status bar Task pane

Task Pane selector

Application close button

Maximize/Restore button

Minimize application button

Minimize window button

Name box

Active cell indicator

Formula bar

Menu bar

Title bar ToolbarsColumn headings

Active cell indicator

Row headings
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7Chapter 1 ✦ Introducing Excel

The row and column headings of the active cell are displayed in different colors to
make it easier to identify the row and column of the active cell.

Figure 1-2: The active cell is the cell with
the dark border — in this case, cell C14.

Navigating with your keyboard
As you probably already know, you can use the standard navigational keys on your
keyboard to move around a worksheet. These keys work just as you would expect:
The down arrow moves the active cell down one row, the right arrow moves it one
column to the right, and so on. PgUp and PgDn move the active cell up or down one
full window. (The actual number of rows moved depends on the number of rows
displayed in the window.)

You can scroll through the worksheet without changing the active cell by turning
on Scroll Lock. This can be useful if you need to view another area of your work-
sheet and then quickly return to your original location. Just press Scroll Lock and
use the direction keys to scroll through the worksheet. When you want to return to
the original position (the active cell), press Ctrl+Backspace. Then, press Scroll Lock
again to turn it off. When Scroll Lock is turned on, Excel displays SCRL in the status
bar at the bottom of the window.

The Num Lock key on your keyboard controls how the keys on the numeric keypad
behave. When Num Lock is on, Excel displays NUM in the status bar, and the keys on
your numeric keypad generate numbers. Most keyboards have a separate set of nav-
igational (arrow) keys located to the left of the numeric keypad. These keys are not
affected by the state of the Num Lock key.

Table 1-2 summarizes all the worksheet movement keys available in Excel.

Tip

Active cell

Tip
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8 Part I ✦ Getting Started with Excel

Table 1-2
Excel’s Worksheet Movement Keys

Key Action

Up arrow Moves the active cell up one row

Down arrow Moves the active cell down one row

Left arrow Moves the active cell one column to the left

Right arrow Moves the active cell one column to the right

PgUp Moves the active cell up one screen

PgDn Moves the active cell down one screen

Alt+PgDn Moves the active cell right one screen

Alt+PgUp Moves the active cell left one screen

Ctrl+Backspace Scrolls to display the active cell

Up arrow* Scrolls the screen up one row (active cell does not change)

Down arrow* Scrolls the screen down one row (active cell does not change)

Left arrow* Scrolls the screen left one column (active cell does not change)

Right arrow* Scrolls the screen right one column (active cell does not change)

* With Scroll Lock on

Navigating with your mouse
To change the active cell by using the mouse, click another cell; it becomes the
active cell. If the cell that you want to activate is not visible in the workbook win-
dow, you can use the scrollbars to scroll the window in any direction. To scroll one
cell, click either of the arrows on the scrollbar. To scroll by a complete screen, click
either side of the scrollbar’s scroll box. You also can drag the scroll box for faster
scrolling.

If your mouse has a wheel on it, you can use the mouse wheel to scroll vertically.
Also, if you click the wheel and move the mouse in any direction, the worksheet
scrolls automatically in that direction. The more you move the mouse, the faster
the scrolling. If you prefer to use the mouse wheel to zoom the worksheet, select
Tools ➪ Options, click the General tab, and then select the Zoom on Roll with
IntelliMouse check box.

Using the scrollbars or scrolling with your mouse doesn’t change the active cell. It
simply scrolls the worksheet. To change the active cell, you must click a new cell
after scrolling.

Tip
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9Chapter 1 ✦ Introducing Excel

Using the Excel Menus and Toolbars
If you’ve used other software, you will have no problem adapting to Excel. Its user
interface (that is, the menus and toolbars) offers few surprises, and they work just
like the other programs you’ve used.

In many cases, you can issue a particular command in several different ways. For
example, if you want to save your workbook, you can use the menu (the File ➪ Save
command), a shortcut menu (right-click the workbook’s title bar and click Save), a
toolbar button (the Save button on the Standard toolbar), or a shortcut key combi-
nation (Ctrl+S). The particular method you use is up to you.

Using menus
Excel, like most other Windows programs, has a menu bar located directly below
the title bar (see Figure 1-3). This menu bar is always available and ready for your
command. The Excel menus change, depending on what you’re doing. For example,
if you’re working with a chart, the menus change to give you options that are appro-
priate for a chart. This all happens automatically, so you don’t even have to think
about it.

Figure 1-3: When you click an Excel menu, you gain access to the 
commands that tell the program what you want to do.

Menu bar Title bar
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10 Part I ✦ Getting Started with Excel

Using the menu is quite straightforward. Click the menu that you want to open, and
it drops down to display menu items. Click the menu item to issue the command.

To issue a menu command from the keyboard, press Alt and then the menu’s hot
key. (The hot key is the underlined letter in the menu.) You can then press the
appropriate hot key for a command on the menu. For example, to issue the Print
command on the File menu, press Alt+F, followed by P.

Some menu items lead to an additional submenu; when you click the menu item,
the submenu appears to its right. Menu items that have a submenu display a small
triangle. For example, the View ➪ Toolbars command has a submenu, as shown ear-
lier in Figure 1-3. Excel’s designers incorporated submenus primarily to keep the
menus from becoming too lengthy and overwhelming to users.

Sometimes, you’ll notice that a menu item appears grayed out. This simply means
that the menu item isn’t appropriate for what you’re doing. Nothing happens if you
try to select such a menu item.

Menu items that are followed by an ellipsis (three dots) always display a dialog box.
Menu commands that don’t have an ellipsis are executed immediately. For example,
the File ➪ Open command results in a dialog box because Excel needs more infor-
mation about the command. Excel doesn’t need any more information to execute
the File ➪ Print Preview command, so Excel performs this command immediately,
without displaying a dialog box.

The Excel menu bar is actually a toolbar in disguise. Consequently, you can move
it to a new location if you prefer. To move the menu bar, just click the set of verti-
cal gray dashes at the left side of the menu bar and drag it to its new location. You
can drag the menu bar to any of the window borders or leave it free-floating.

Tip

Tip

Changing Your Mind

Just about every command in Excel can be reversed by using the Edit ➪ Undo command.
Select Edit ➪ Undo after issuing a command in error, and it’s as if you never issued the com-
mand. You can reverse the effects of the last 16 commands that you executed by selecting
Edit ➪ Undo more than once.

Rather than use Edit ➪ Undo, you may prefer to use the Undo button on the Standard tool-
bar. If you click the arrow on the right side of the button, you can see a description of the
commands that can be reversed. In addition, you can press Ctrl+Z to undo the last action.

The Redo button performs in the opposite direction of the Undo button: Redo repeats com-
mands that have been undone.
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11Chapter 1 ✦ Introducing Excel

When you click a menu, you may find that not all of the menu items are displayed.
If this is the case, the adaptive menu option is in effect. I highly recommend that
you turn off this option. To do so, choose View ➪ Toolbars ➪ Customize. In the
Customize dialog box, click the Options tab and make sure that a check mark is
next to Always Show Full Menus. Note to Microsoft: This is, without a doubt, the
dumbest option you guys have ever come up with!

Using shortcut menus
Besides the omnipresent menu bar, Excel features a slew of shortcut menus, which
you access by right-clicking just about anything within Excel. Shortcut menus don’t
contain every relevant command, just those that are most commonly used for what-
ever is selected.

As an example, Figure 1-4 shows the shortcut menu that appears when you right-
click a cell. The shortcut menu appears at the mouse-pointer position, which makes
selecting a command fast and efficient. The shortcut menu that appears depends
on what you’re doing at the time. For example, if you’re working with a chart, the
right-click shortcut menu contains commands that are pertinent to what is
selected.

Figure 1-4: Click the right mouse
button to display a shortcut menu
with the commands that you are
most likely to use.

Tip
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12 Part I ✦ Getting Started with Excel

Using shortcut keys
Some menu items also have shortcut keys associated with them. For example, the
File ➪ Save command’s shortcut key combination is Ctrl+S. As you use Excel, you’ll
find that learning the shortcut keys for commands you use often can save you a lot
of time.

The best way to learn the shortcut keys is to watch for them on the Excel menus.
The most useful ones display next to the menu item when you open the menus.

Using toolbars
Excel includes convenient toolbars that provide another way of issuing commands.
In many cases, a toolbar button is simply a substitute for a menu command. For
example, the Copy button is a substitute for Edit ➪ Copy. Some toolbar buttons,
however, don’t have a menu equivalent. One example is the AutoSum button, which
automatically inserts a formula to calculate the sum of a range of cells.

To learn what the toolbar buttons do, you can hold the mouse pointer over a tool-
bar button (but don’t click it). A small box that tells you the name of the button
appears. Often, this provides enough information for you to determine whether
the button is what you want. If these toolbar tips do not display, choose Tools ➪
Customize to display the Customize dialog box. Click the Options tab, and place
a check mark next to Show ScreenTips on Toolbars.

Table 1-3 lists some of Excel’s more useful built-in toolbars.

Table 1-3
Excel’s Most Useful Built-In Toolbars

Toolbar Use

Standard Issues commonly used commands

Formatting Changes how your worksheet or chart looks

Borders Adds borders around selected areas

Chart Manipulates charts

Drawing Inserts or edits drawings on a worksheet

Control Toolbox Adds controls (buttons, spinners, and so on) to a worksheet

Formula Auditing Identifies errors in your worksheet

Picture Inserts or edits graphic images

PivotTable Works with pivot tables
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Toolbar Use

Protection Controls what types of changes can be made in your worksheet

Reviewing Provides tools to use workbooks in groups

Text to Speech Provides tools to read aloud cell contents

Web Provides tools to access the Internet from Excel

WordArt Inserts or edits a picture composed of words

Hiding or showing toolbars
By default, Excel displays two toolbars (named Standard and Formatting). You have
complete control over which toolbars are displayed and where they are located. In
addition, you can create custom toolbars, made up of buttons that you find most
useful.

To hide or display a particular toolbar, choose View ➪ Toolbars or right-click any
toolbar. Either of these actions displays a list of common toolbars (but not all tool-
bars). The toolbars that have a check mark next to them are currently visible. To
hide a toolbar, click it to remove the check mark. To display a toolbar, click it to
add a check mark.

For control over all toolbars, select Tools ➪ Customize. In the Customize dialog box,
click the Toolbars tab to display a list of all available toolbars. Place a check mark
next to the toolbars that you want to be displayed.

Moving toolbars
Toolbars can be moved to any of the four sides of the Excel window, or they can
be free-floating. A free-floating toolbar can be dragged on-screen anywhere that you
want. You also can change a toolbar’s size simply by dragging any of its borders. To
hide a free-floating toolbar, click its Close button.

When a toolbar isn’t free-floating, it’s said to be docked. A docked toolbar is stuck
to the edge of the Excel window and doesn’t have a title bar. Therefore, a docked
toolbar can’t be resized.

To move a docked toolbar, click the toolbar’s vertical gray dashes and drag. To
move a free-floating toolbar, click and drag the toolbar’s title bar. When you drag a
toolbar toward the window’s edge, it automatically docks itself there. When a tool-
bar is docked, its shape changes to a single row or single column.

Note
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14 Part I ✦ Getting Started with Excel

Working with Dialog Boxes
Many Excel commands display dialog boxes. In fact, all menu items that end with an
ellipsis (three dots) display a dialog box. A dialog box is simply the Excel way of get-
ting more information from you. For example, if you choose View ➪ Zoom (which
changes the magnification of the worksheet), Excel can’t carry out the command
until it finds out from you what magnification level you want.

The Excel dialog boxes vary in how they work. A few of them can remain on-screen
as you work (for example, the Find dialog box, which appears when you select Edit ➪
Find). But most of Excel’s dialog boxes must be dismissed before you can do any-
thing. If the dialog box obscures an area of your worksheet that you need to see,
simply click the dialog box’s title bar and drag the box to another location.

When a dialog box appears, you make your choices by manipulating the controls.
When you’re finished, click the OK button (or press Enter) to continue. If you change
your mind, click the Cancel button (or press Esc), and nothing further happens —
it’s as if the dialog box never appeared.

Understanding dialog box controls
Most people find working with dialog boxes to be quite straightforward and natural.
If you’ve used other programs, you’ll feel right at home. The controls can be manip-
ulated either with your mouse or directly from the keyboard.

Figure 1-5 shows the Print dialog box, which contains most of the common dialog
box controls you’ll encounter. Table 1-4 describes these controls and a few others
you may encounter.

Figure 1-5: Use the
dialog box controls to
enter information and
control the dialog box.

Drop-down box

Buttons

Check box Spinner

Option buttons
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Table 1-4
Common Dialog Box Controls

Name Description

Buttons A button control is about as simple as it gets. Just click it, and it
does its thing. Pressing the Alt key and the button’s underlined
letter is equivalent to clicking the button.

Option buttons Option buttons are sometimes known as radio buttons because
they work like the preset station buttons on an old-fashioned car
radio. Like those car radios, only one option button at a time can be
“pressed.” When you click an option button, the previously selected
option button is unselected. Option buttons usually are enclosed in
a group box, and a single dialog box can have several sets of option
buttons.

Check boxes A check box control is used to indicate whether an option is on or
off. Unlike option buttons, each check box is independent of the
others. Clicking a check box toggles it on and off.

Range selection A range selection box enables you to specify a worksheet range by 
boxes dragging inside the worksheet. A range selection box has a small

button that, when clicked, collapses the dialog box to make it easier
for you to select the range by dragging in the worksheet.

Spinners A spinner control makes specifying a number easy. You can click the
arrows to increment or decrement the displayed value. A spinner is
almost always paired with an edit box. You can either enter the value
directly into the edit box or use the spinner to change it to the
desired value.

List boxes A list box control contains a list of options from which you choose.
If the list is longer than will fit in the list box, you can use its vertical
scrollbar to scroll through the list.

Drop-down boxes Drop-down boxes are similar to list boxes, but they show only a
single option at a time. When you click the arrow on a drop-down
box, the list drops down to display additional choices.

Navigating dialog boxes
Navigating dialog boxes is generally very easy — you simply click the control you
wish to activate.

Although dialog boxes were designed with mouse users in mind, you can also use
the keyboard. Every dialog box control has text associated with it, and this text
always has one underlined letter (a hot key or accelerator key). You can access the
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16 Part I ✦ Getting Started with Excel

control from the keyboard by pressing the Alt key and then the underlined letter.
You also can use Tab to cycle through all the controls on a dialog box. Shift+Tab
cycles through the controls in reverse order.

When a control is selected, it appears with a darker outline. You can use the space-
bar to activate a selected control.

Using tabbed dialog boxes
Many of Excel’s dialog boxes are “tabbed” dialog boxes. A tabbed dialog box
includes notebook-like tabs, each of which is associated with a different panel.
When you click a tab, the dialog box changes to display a new panel containing a
new set of controls. The Options dialog box, which appears in response to the
Tools ➪ Options command, is a good example. This dialog box is shown in Figure
1-6; it has 13 tabs, which makes it functionally equivalent to 13 different dialog
boxes.

Figure 1-6: Use the dialog box tabs to select different 
functional areas in the dialog box.

Tabbed dialog boxes are quite convenient because you can make several changes in
a single dialog box. After you make all of your setting changes, click OK or press
Enter.

To select a tab by using the keyboard, use Ctrl+PgUp or Ctrl+PgDn, or simply press
the first letter of the tab that you want to activate.

Tip

Tabs

Tip
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Creating Your First Excel Worksheet
This section presents an introductory hands-on session with Excel. If you haven’t
used Excel, you may want to follow along on your computer to get a feel for how
this program works.

In this example, you’ll create a simple monthly sales projection table along with a
chart.

Specifying Options in Excel: More Confusing 
Than It Should Be

Excel is a very flexible program, and it provides you with many options to control how it
looks and works. But the problem is finding those options.

The Options dialog box is essentially Excel’s junk drawer. With every new upgrade, the
developers cram more options into this dialog box. This dialog box is a prime candidate for
the cover of the Journal of Bad User Interface Design.

I’ve been using Excel for more than a decade, and when I bring up the Options dialog box,
I still can’t remember which tab to use. Typically, it will take two or three tab clicks to locate
the desired option. But the main problem with the Options dialog box is inconsistency.
Some of the options affect only the active sheet, and others affect Excel as a whole — and
they are scattered all over the place, with no clear indication as to which is which.

To make matters worse, the Options dialog box contains a number of buttons that, when
clicked, display other dialog boxes that contain even more options. Dig around in Excel’s
Options dialog box, and you’ll find buttons that display a half dozen other dialog boxes.

But wait! There’s more. Don’t forget about the Customize dialog box (Tools ➪ Customize).
Here you’ll find still more options, which are not accessible from the Options dialog box. I’m
not done yet. When you save a workbook, the Save As dialog box leads to even more
options, accessible via the Tools menu in the dialog box. I’m sure most Excel users could
never find this dialog box even if they knew what they were looking for.

We old-timers have grown accustomed to this user-interface nightmare, and we tend to
take it in stride. But I have deep and sincere pity for the new user who simply wants to
change a few things — and ends up on an unexpected adventure that may or may not be
successful.

Every new release of Excel provides Microsoft with an opportunity to clean up this confus-
ing mess, and they most certainly have the resources to do so. But, for some reason,
Microsoft just keeps cramming more stuff into the junk drawer.
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18 Part I ✦ Getting Started with Excel

Getting started on your worksheet
To begin, launch Excel by using the Windows Start button. You’ll be greeted with an
empty workbook.

The sales projection will consist of two columns of information. Column A will con-
tain the month names, and column B will store the projected sales numbers. You
begin by entering some descriptive titles into the worksheet. Here’s how to begin:

1. Move the cell pointer to cell A1 by using the direction keys. The Name box
displays the cell’s address.

2. Enter Month into cell A1. Just type the text and then press Enter. Depending
on your setup, Excel either moves the cell pointer to a different cell, or the
pointer remains in cell A1.

3. Move the cell pointer to B1, type Projected Sales, and press Enter.

Filling in the month names
In this step, you enter the month names in column A.

1. Move the cell pointer to A2 and type Jan (an abbreviation for January).

At this point, you could enter the other month name abbreviations manually,
but we’ll let Excel do some of the work by taking advantage of the AutoFill
feature.

2. Make sure that cell A2 is selected. Notice that the active cell is displayed with
a heavy outline. At the bottom-right corner of the outline, you’ll see a small
square known as the fill handle. Move your mouse pointer over the fill handle,
click, and drag down until you’ve highlighted from A2 down to A13. Release
the mouse button, and Excel will automatically fill in the month names.

Your worksheet should resemble the one shown in Figure 1-7.

Figure 1-7: Your worksheet, after
entering the column headings and
month names.
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Entering the sales data
Assume that January’s sales are projected to be $50,000 and that sales will increase
by 2.5 percent in each of the subsequent months. 

1. Move the cell pointer to B2 and type $50,000, the projected sales for January.
If your currency symbol is not a dollar sign, substitute the appropriate cur-
rency symbol.

2. To enter a formula to calculate the projected sales for February, move to cell
B3 and enter the following: =B2*102.5%. When you press Enter, the cell will
display $51,250.0. The formula returns the contents of cell B2, multiplied by
102.5%. In other words, February sales are projected to be 2.5% greater than
January sales.

3. The projected sales for subsequent months will use a similar formula. But
rather than retype the formula for each cell in column B, once again take
advantage of the AutoFill feature. Make sure that cell B3 is selected. Click
the cell’s fill handle, drag down to cell B13, and release the mouse button.

At this point, your worksheet should resemble the one shown in Figure 1-8. Keep in
mind that, except for cell B2, the values in column B are calculated with formulas.
To demonstrate, try changing the projected sales value for the initial month, January
(in cell B2). You’ll find that the formulas recalculate and return different values. But
these formulas all depend on the initial value in cell B2.

Figure 1-8: Your worksheet, after
creating the formulas.

Summing the values
The worksheet displays the monthly projected sales, but what about the total sales
for the year? To display the yearly total, another formula is required.

1. Move to cell A14 and type Total.

2. Move to cell B14, which is the first empty cell below the sales data.
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3. Locate the AutoSum button, which is on the Standard toolbar. The AutoSum
button contains the Greek letter sigma.

4. Click the AutoSum button and press Enter.

You’ll find that Excel added this formula to cell B14: =SUM(B2:B13)

This formula calculates the sum of the cells beginning with B2 and ending with B13
and displays the result. You could have typed that formula yourself, but using the
AutoSum button is faster.

Making your worksheet look a bit fancier
At this point, you have a functional worksheet — but it could use some help in the
appearance department.

1. Start by adding a title above the table. You’ll need to insert some new rows, so
select cell A1 and choose Insert ➪ Rows to insert one new row. An additional
blank row would be even better, so issue this command again.

Notice that the existing information is “pushed down” to make room for the
new rows. If you examine the formulas, you’ll find that they still work — Excel
adjusted the cell references just as you may have expected.

2. Move to cell A1 and type Sales Projections.

3. To make this title stand out, select cell A1 and click the Bold button on the
Formatting toolbar. (That button has a B on it.) Then change the font size to
something larger, say 14 points. The font size control is directly to the left of
the Bold button.

4. You could apply other formatting to the actual table, but let Excel do the
work. Start by selecting any cell within the data table — for example, cell B3.
The exact cell doesn’t matter because Excel will figure out the table’s bound-
aries. Just make sure that you don’t select a cell in rows 1 or 2, which are out-
side of the table. (Remember that the table now begins in row 3 because of
the rows inserted in Step 1.)

5. Click the Format menu and choose AutoFormat. Two things happen: Excel
determines the table boundaries and highlights the entire table, and it dis-
plays the AutoFormat dialog box.

6. The AutoFormat dialog box offers 16 canned formats to choose from (plus one
called None that removes all formatting). Click the table format that you want
to apply.

7. Click the OK button. Excel applies the formats to your table.

8. If you don’t like the result, choose Edit ➪ Undo to return to the original for-
matting. Or use the Format ➪ AutoFormat command again and try a different
option. Because the table contains currency values, you may want to choose
an AutoFormat that displays either two decimal places or no decimal places. 
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Creating a chart
Next, you create a chart that shows the projected sales for each month.

1. Start by selecting the data that will appear in the chart. In this case, click cell
A3, and then drag down and to the right to include cell B15. Notice that the
total row (row 16) is not included in the selection.

2. Click the Chart Wizard button, in the Standard toolbar (it has a picture of a
column chart).

3. You’ll see the Chart Wizard dialog box, which is shown in Figure 1-9.

4. In the Chart Type list, click Column. You’ll see seven subtypes listed.

5. The default subtype will be fine, so click Finish to create your chart.

Figure 1-9: The Chart Wizard dialog box.

Excel puts the chart in the middle of the screen. You can drag the chart to a new
location, and even change the size and proportions by clicking and dragging on the
chart’s border. You can make many other changes to the chart. For example, you
may want to remove the legend. To do so, click the legend and press Del.

Figure 1-10 shows the chart after it was moved adjacent to the data table.

This workbook is available on the companion CD-ROM.On the
CD-ROM
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Figure 1-10: Your worksheet, after creating a chart.

Printing your worksheet
Printing your worksheet is very easy (assuming that you have a printer attached
and that it works properly). Before printing, it’s a good idea to do a print preview.

1. First, make sure that the chart is not selected. Just press Esc or click any cell
to deselect the chart.

2. Click the Preview button on the Standard toolbar. Excel opens a new window
and displays a preview of the printed output.

3. Click Close to return to your worksheet.

4. If the preview was acceptable, click the Print button on the Standard toolbar.
(This button has an image of a printer on it.) The worksheet is printed using
the default settings.

You may need to adjust the size or position of the chart so it is not split across two
pages.

Saving your workbook
Until now, everything that you’ve done has occurred in your computer’s memory. If
the power should fail, all may be lost — unless Excel’s AutoRecover feature hap-
pened to kick in. It’s time to save your work to a file on your hard drive.

1. Click the Save button on the Standard toolbar. (This button looks like a floppy
disk.) Excel responds with the Save As dialog box.

2. In the box labeled File Name, enter Monthly Sales Projection, and then click
Save or press Enter.

Note
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Excel saves the workbook as a file. The workbook remains open so that you can
work with it some more.

By default, Excel saves a copy of your work automatically every ten minutes. To
adjust this setting (or turn if off), use the Options dialog box. (Select Tools ➪

Options and click the Save tab.)

But, of course, you’ve barely scratched the surface. The remainder of this book will
cover these tasks (and many, many more) in much greater detail.

✦ ✦ ✦

Note
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